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Cloud Secure Integration with ADFS

Introduction

About this guide

This document outlines the Cloud Secure integration with Microsoft's Active Directory Federation
Services (ADFS). The guide explains the configuration required to setup Cloud Secure as a third-party
Identity Provider (IdP) with ADFS. It is assumed that Office 365 is already configured as an IdP in ADFS.

To configure Office 365 to authenticate directly with Cloud Secure, refer to Cloud Secure Microsoft
Office 365 guide which explains the configuration and benefits of using Cloud Secure as standalone
IdP.

Overview

Cloud Secure provides secure access to anyone, anytime on a hybrid IT environment where enterprise
companies are combining the best of the cloud with their own localized data centers.

Cloud Secure uses Security Assertion Markup Language (SAML) for exchange of authentication
between client devices (Windows, MacOS, iOS, Android), Service Providers (Cloud applications like
Office 365, Salesforce etc.) and Identity Providers (Pulse Connect Secure) to provide Single-Sign on
access seamlessly to applications. In addition, Cloud Secure provides a greater level of flexibility with
integration to many third-party IdP's like PingOne, OKTA, and Active Directory Federation Services
(ADFS) for seamless migration of existing customers.

Cloud Secure ADFS Integration

Pulse Secure's Cloud Secure solution is capable of providing authentication as well as secure single
sign-on to Office 365 services as a standalone Identity Provider. Most of the companies who are using
Office 365 have also implemented Active Directory Federation Services (ADFS) for authentication.

Note: In many cases, it would not be feasible for a company that has already deployed ADFS as their
Identity Provider to change their Office 365 configuration.

The deployment discussed in the guide explores an alternative approach called IdP chaining, where
Cloud Secure (PCS) acts as IdP for ADFS and handles all the authentication requests. This helps the
customer to get the benefits of Cloud Secure such as compliance checks, secure single sign-on
through VPN tunneling without making major changes to the existing setup. Pulse Connect Secure
(PCS) is used as Identity Provider in Cloud Secure solution.

© 2018 Pulse Secure, LLC All rights reserved.



Cloud Secure Integration with ADFS

Deployment Scenarios

ADFS allows Pulse Connect Secure (PCS) to be configured as Third-Party Identity Provider and
redirects all the SAML Authentication requests from Service Providers (SP) to PCS and vice-versa.
In this deployment scenario,

e ADFS is configured as Service Provider (SP) in PCS
e PCSis configured as claims provider in ADFS
e ADFS is configured as Identity Provider in SP

Cloud Secure integration with ADFS supports both SP initiated and IdP initiated SSO.

Office 365 access through applications (SP Initiated SSO)

When a user tries to access cloud service, the SAML enabled Service Provider generates SAML request
and redirects it to ADFS. ADFS in turn redirects the incoming SAML authentication requests to PCS.
PCS authenticates the user, and generates SAML AuthNResponse after compliance posture
assessments. ADFS relays the response to Service provider thus providing access to the cloud
resource

Figure 1 Deployment Diagram: Cloud Secure ADFS Integration - SP Initiated

Password Hashes

uQ-usis
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L Authentication/Compliance
Authentication -
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e - Secure Sign-On

AD FS

Pulse Connect Secure

Note: If the client has an existing VPN connection to PCS, then the same session will be reused and
provides seamless SSO without asking for credentials

Mobilelron and AirWatch Third-party MDM servers can also be used in this solution to manage devices
and to evaluate compliance posture of the mobile devices
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Cloud Secure Integration with ADFS

Office 365 access through bookmark (IdP Initiated SSO)

In IdP Initiated Single Sign-on, user first logs into PCS through browser. After authentication and
compliance posture assessments, PCS shows up the browser page with all the configured bookmarks.
When the user access the Office 365 bookmark, PCS generates the SAML assertion and relays it to
ADFS. ADFS again relays the Assertion to Office 365 and provides seamless access to cloud resource

Figure 2 Deployment Diagram: Cloud Secure ADFS Integration - IdP Initiated
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Note: Cloud Secure ADFS integration solution works well with all Service Providers (like Salesforce,
Zendesk etc.,), provided the SPs should be configured as Relying Party Trusts in ADFS
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Pre-requisites

Prerequisites for this solution include:

|dentity Management Provider: Active Directory Federation Services (ADFS)

Service Provider (Office 365): Office 365 Subscription. Office 365 Service Provider should be
configured as Relying Party Trust in ADFS and ADFS is configured as Identity Provider in
Office365 SP

Wildcard or SAN Certificates: Wildcard or Subject Alternative Name (SAN) Certificates are
required. SAN certificate should include the fgdn of PCS as well as ADFS.

AD/LDAP Server: AD/LDAP with directory synchronization enabled

Clients: iOS Device/ Android Device/ Windows/ MAC OS X Desktops

(Optional) MDM Servers: Pulse Workspace Server/ Mobilelron/ AirWatch servers are used for
Mobile Device Management and Mobile Compliance posture assessments

Limitations

Email Access through Native Email Client in iOS and GMAIL in Android are yet to be validated

Supported Platforms

Browsers (Chrome, Safari, Firefox, Internet Explorer)

Microsoft Outlook 2016 on desktops and mobiles

Microsoft Outlook 2013 with a registry update

Microsoft applications (Word, PowerPoint, Excel) on desktops and mobiles



Cloud Secure Integration with ADFS

End-User Flow

Sign-in experience for end user is different based on his location and the device used to access Office
365 services.

Access through Outlook client (SP Initiated SSO)

Cloud Secure requires Microsoft Office 2013 or 2016 client for providing SSO access to emails through
modern authentication. In Office 2016 client, Microsoft has added support for modern authentication
(for doing web browser SSO) and is enabled by default. Earlier versions of outlook client support only
ECP profile for SAML exchanges.

Follow below steps to enable modern authentication in Office 2013 clients on Windows platform:

1. Update Office 2013 client to obtain the update that includes the new Azure Active Directory
Authentication Libraries (ADAL) based authentication features.

2. Set the following registry keys.

HKCU\SOFTWARE\Microsoft\Office\15.0\Common\ldentity\EnableADAL | REG_DWORD | 1
HKCU\SOFTWARE\Microsoft\Office\15.0\Common\ldentity\Version REG_DWORD | 1

@ Note: End-Users are usually not recommended to change the registry settings

Below steps need to be performed once for setting up Outlook client to access emails:

1. Add email account in Outlook client by navigating to File > Add Account (in Windows) or Tools
> Accounts (in MAC). Provide only the name and email address (without password) and click
Next. In latest version of Outlook client, provide only Email address

2. Outlook client starts searching for server settings and once the details are obtained, new
browser windows is opened and gets redirected to PCS login page.

3. Provide user credentials and ‘Sign In’ for authenticating with PCS.

4. After successful authentication with PCS, SAML SSO is triggered and email account gets added
to Outlook.

Access through browser (SP Initiated SSO)

1. Open web browser and access Microsoft login URL “https://login.microsoftonline.com/”

2. Provide Email address and press tab. It automatically redirects to PCS login page
3. Provide credentials in the user login page to authentication to PCS

4. After successful authentication, user gets redirected to ADFS, ADFS in turn redirects to
Microsoft Office 365 portal site giving access to Office365 services

© 2018 Pulse Secure, LLC All rights reserved.
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Cloud Secure Integration with ADFS

@ Note: If the client has an existing VPN connection to PCS, then the same session will be reused and
provides seamless SSO without asking for credentials

Access through PCS bookmark (IdP Initiated SSO)

1. Open web browser and access PCS external URL (Ex: https://sso.pulsesecure.net)
2. Provide credentials in the user login page to authenticate to PCS
3. Once authenticated, click on Office 365 Web Bookmark in the homepage

4. Single Sign-On will happen and user gets redirected to ADFS, ADFS in turn redirects to
Microsoft Office 365 portal site giving access to Office 365 services

© 2018 Pulse Secure, LLC All rights reserved.
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Cloud Secure Integration with ADFS

Configurations

This section covers the configurations required on ADFS and PCS for Cloud Secure integration with
ADFS.
Active Directory Federations Services configurations include:

e Downloading Metadata from PCS and upload it in ADFS

e Adding Cloud Secure(PCS) as Claims Provider Trust in ADFS

e Adding Claim rules to process the SAML authentication requests
e Enabling RelayState for Idp initiated single sign-on

Pulse Connect Secure configurations include:

e Enabling and configuring SAML in PCS

e Adding ADFS metadata

e Configuring ADFS as Service Provider in PCS

e Configuring bookmark for Idp initiated single sign-on

ADFS Configurations

Before configuring PCS as Claims Provider Trust in ADFS, download metadata from PCS and upload it
in ADFS.

Download PCS metadata

To download PCS SAML metadata:
1. Login to PCS admin console.
2. Go to Authentication > Signing In > Sign-in SAML > Metadata Provider
3. Click Download Metadata and save the file

Figure 3 Download Metadata

\' Secure System Administrators  Users  Maintenance ~ Wizards

Signing In

This is configuration of Pulse Connect Secure (SA) SAML Metadata provider.

*Entity Id: th ML identifie of ecure a figured at SAML Settings.

*Metadata Validity: 365  days
Do Not Publish IdP in Metadata

Save Metadata Provider

@ Note: The Metadata should be downloaded only after finishing the basic SAML configurations in PCS

© 2018 Pulse Secure, LLC All rights reserved. 10



Cloud Secure Integration with ADFS

Adding Cloud Secure (PCS) as Claims Provider trust

1. Login to AD Server where ADFS services are enabled
2. Open ADFS management snap-in
3. Right Click on “Claims Provider Trusts” and Select “Add Claims Provider Trust”

Figure 4 ADFS:Claims Provider Trust

i File Action View Window Help

- |&]*
dl
[ ADFS Claims Provider Trusts | Actions
B retn | Claims Provider Trusts 4
D N Enabled
4 [ Trust Relationships me:':: ¥, = 1
= Claims Prowi ive Directory v:: Add Claims Provider Trust...
7] Relying Pa| | Add Claims Provider Trust... ‘ View 4
[ Attri -
— tm'fmté 3 View » New Window from Here
p 2] Authenticatior
New Window from Here G Refresh
Refresh Help
Help
4. Click Start

Figure 5 ADFS Claims Provider Trust Wizard: Welcome

Welcome to the Add Claims Provider Trust Wizard
@ Welcome

This wizard will help you add a new claims provider trust to the AD FS configuration database. Claims
@ Select Data Source providers issue claims about a userin a security token for a particular transaction.
@ Readyto Add Trust . . N . . . . .
The claims provider trust that this wizard creates defines how this Federation Service recognizes the claims
@ Finish provider and consumes the claims that it issues. You can define acceptance transform rules for issuing claims
to the relying party after you complete the wizard.

| = Previous | |

5. Click Browse and select PCS Metadata file (As mentioned in “Download PCS metadata” section)

© 2018 Pulse Secure, LLC All rights reserved. 11



Cloud Secure Integration with ADFS

Figure 6 ADFS Claims Provider Trust Wizard: Metadata Upload

Select Data Source

SE L Select an option that this wizand will use to obtain data about this claims provider:
@ Welcome

Select Data So
@ 3 -oures Lse this option to import the necessary data and certificates from a claims provider organization that
@ Readyto Add Trust publishes its federation metadata online or on 3 local networlk.

() Import data about the claims provider published online or on a local network

@ Finish Federation metadata address thost name or URL):

Example: fz fabrikkam .com or https://fs fabrkam.com/

(®) Import data about the claims provider from a file

lse this option to import the necessary data and certficates from a claims provider organization that has
provided its federation metadata in a file.

Federation metadata file location:

[ || Brawse_ I

() Erter claims provider trust data manually

lse this option to manually input the necessany data about this claims provider organization.

6. Provide the claims provider display name
7. Select Next

© 2018 Pulse Secure, LLC All rights reserved. 12



Cloud Secure Integration with ADFS

Figure 7 ADFS Claims Provider Trust Wizard: Claims Provider Name

Specify Display Mame

Type the display name and ary optional notes for this claims provider.

eps
Welcome Display name:
Select Data Source |Cloud Secure|
Specify Display Mame Notes:
Ready to Add Trust
Finish

Figure 8 ADFS Claims Provider Trust Wizard: Review

Ready to Add Trust

Steps The claims provider trust has been configured. Review the following settings, and then click Nexd to add the
Welcome claims provider trust to the AD F5 corfiguration database.

(=]

@ Select Data Source Monitoring | |dertfiers | Certficates | Encryption | Offered Claims | Orgarization | Endpoints | Note < | >
® Specfy Display Name Specify the tnust monitoring settings for this claims provider trust.
=
@

Ready to Add Trust Claims provider’s federation metadata LURL:
Finigsh |

[] Monitor claims provider
[] Mutomatically update claims provider

This claims provider's federation metadata was last checked on:

< NEVEr =

This claims provider tust was last updated from federation metadata on:

< NEever =

© 2018 Pulse Secure, LLC All rights reserved. 13



Cloud Secure Integration with ADFS

8. C(lick Close

Figure 9 ADFS Claims Provider Trust Wizard.: Finish

Steps The claims provider trust was successfully added to the AD FS corfiguration database.

@ Welcome You can modify this claims provider trust by using the Propedies dialog box in the AD FS Management
@ Select Data Source snap-n.

@ Specify Display Name [] ©pen the Edit Claim Rules dialog for this claims provider trust when the wizard closes

@ Readyto Add Trust

@ Finish

9. ADFS claim rules page is displayed, Do not add any rule. Click OK.

Figure 10 ADFS Claim Rules

Acceptance Transform Rules

The following acceptance transform rules specify the incoming claims that will be accepted
from the claims provider and the outgoing claims that will be sent to the relying party trust.

Order | Rule Mame | Issued Claims

Add Rule... | [ Edit Rule... | | Remowe Rule...

© 2018 Pulse Secure, LLC All rights reserved. 14



Cloud Secure Integration with ADFS
10. ADFS sets SHA-256 as default Secure hash algorithm, change it to SHA-1.
To change Secure hash algorithm:

a. Goto “Claims Provider Trusts”. Right click on Cloud Secure (Claims provider added above).
b. Select “Properties” and click “Advanced” tab.

c. Select "SHA-1" Secure hash algorithm from the drop-down list.

Figure 11 ADFS: Secure Hash Algorithm

Maonitoring Identifiers I Certificates I Encryption
Offered Claims Organization I Endpoints I Motes | Advanced

Specify the secure hash algorthm to use for this claims provider trust .

Secure hash algorthm: | SHA-1

SHA-256

© 2018 Pulse Secure, LLC All rights reserved.



Cloud Secure Integration with ADFS

Adding Claim Rules

1. Select "Relying Party Trusts”. Right Click on “Office365" and click “Edit Claim Rules”
2. Select “Issuance Transform Rules” tab and click "Add Rule”

Figure 12 ADFS: Office365 Relying Party Trust

G File Action View Window Help

- IE X
Al
] ADFS Relying Party Trusts | Actions
b g _S[ew;:; Jationshi Display MName Enabled Type |dentifier M'
“ rust Relationships Device Registration Service Yes WS-T... um:ms-drs:adfs pulsesecursga net =
£ Claims Provider Trusts T oo HereeohCre e Relying Party Trust..
| Relying Party Trusts SFDC P Add Non-Claims-Aware Relying Party...
] Attribute Stores [ Edit Claim Rules... 1| View R
B[] Authentication Policies Disable
& New Window from Here
Properties
i Refresh
Delete o
Help Help
Update from Federation Metadata...
Edit Claim Rules...
Disable
Properties
K Delete
Help

Note: Office365 federates the authentication to ADFS and this happens only when it is configured as
@ “Relying Party Trusts” in ADFS and ADFS is configured as I1dP in Office365

3. Select "Pass Through or Filter an Incoming Claim” as Claim rule template.
4. Click "Next”

Figure 13 ADFS:Claim Rules Wizard

Select Rule Template

Steps Select the template for the claim rule that you want to create from the following list. The description provides
@ Choose Rule Type details about each claim rule template.
@ Corfigure Claim Rule Claim rule template:

Pass Through or Fiter an Incoming Claim [

Claim rule template description:

Using the Pass Through or Filter an Incoming Claim rule template you can pass through all incoming claims
with a selected claim type. You can also fiter the values of incoming claims with a selected claim type.
For escample, you can use this rule template to create a rule that will send all incoming group claims. You
can also use this rule to send only LUIPM claims that end with “@fabrikam™. Multiple claims with the same
claim type may be emitted from this rule. Sources of incoming claims warny based on the rules being edited
For more information on the sources of incoming claims, click Help.

< Previous | | Mest = | | Cancel

© 2018 Pulse Secure, LLC All rights reserved. 16



Cloud Secure Integration with ADFS

5. Provide “Claim rule name”
6. Select Incoming Claim type as “Name ID" and Incoming name ID format as “Persistent

|dentifier”
7. Select “Pass through all claim values”
8. Click Finish

Figure 14 ADFS: Claim Rules Wizard: Transform Claim Rule

Configure Rule

Steps You can configure this rule to pass through or filter an incoming claim. You can also configure this rule to fiter

@ Choose Rule Type claims that are generated by previous rules. Specify the claim type and whether only some claim values or all
claim values should pass through.

@ Configure Claim Rule

Claim rule name:
|CloudSecureRule
Rule template: Pass Through or Fiter an Incoming Claim

Incoming claim value: |

Pass through only claim values that match a specific email suffic value:

Email suffix value: |

Example: fabrkam com
Pass through only claim values that start with a specific value:

Starts with: |

Example: FABRIKAM

9. Clickon"Up arrow" on right side of the screen and move “CloudSecureRule” above the existing

rules
10. Select “OK”

© 2018 Pulse Secure, LLC All rights reserved. 17



Figure 15 ADFS: Claim Rules Wizard: Transform Claim Rule

L ¥ Edit Claim Rules for ©O365

Issuance Transform Rules | lssuance Authorization Rules [ Delegation Authorization Rules |

The following transform rules specify the claims that will be sent to the relying party.

Order  Fule Mame lzsued Claims
i CloudSecure Fule MName 10 |
2 Claim 3 Commaon Name )
3 Claim 2 Mame 1D
4B
Add Rule... | | Edit Rule... | | Remowe Rule...
oK | | cancel

11. With all the above configurations, Cloud Secure(PCS) is successfully added as “Claims Provider”
in ADFS. When the user access Office365 services then a login page prompts up asking user
to select either "ADFS” or “Cloud Secure” for authentication.

12. Select “Cloud Secure” to get Secure Single Sign-on experience with existing VPN connection.

13. To avoid the additional selection page and use only Cloud Secure for Office 365 authentication

federation, Launch "Windows PowerShell” and give the following command:

% Set-AdfsRelyingPartyTrust -Targetldentifier ‘urn:federation:MicrosoftOnline’ -ClaimsProviderName
@(“"Cloud Secure”)

Figure 16 ADFS Claim Rules Wizard:Transform Claim Rule

ey Administrator: Windows PowerShell |L‘i-

ministra

= Set-AdfsRelyingPartyTrust -TargetIdentifier 'urn:federation:MicrosoftOnline’ -ClaimsProwviderN

dministrato
dministrato
dmin

18



Cloud Secure Integration with ADFS

Enable Relay State for Idp Initiated Single Sign-on

In IdP initiated scenario, PCS triggers SAML assertion to ADFS when the user clicks on ADFS bookmark.
However, user is not redirected to Office 365 portal, as ADFS is not aware of where the user should
be redirected further. Below configuration settings enables ADFS service to relay the SAML assertion
from ADFS to target cloud service

1. Go to C:\Windows\ADFS

2. Open the file Microsoft.IdentityServer.Servicehost.exe.config

3. Insert <useRelayStateForldplnitiatedSignOn enabled="true” /> wunder the section

<microsoft.identityServer.web>

Figure 17 ADFS Relay State configuration

s ADFS S e

@© 1 [J » ThisPC » Local Disk (C)) » Windows » ADFS v | [ search ADFS o |

Name Date modified Type Size

v ~
¢ Favorites =

=| %, Microsoft.|dentityServer.Service.dll 15/2016 10;19 AM  Application extens... 679 KB
B Desktop = %) ity pplication exte
' || Microsoft.IdentityServer.Service.mof /22/201312:12PM  MOF File 4KB

& Downloads

016 10:19 AM  Application 42 KB
/2017 2:04 PM CONFIG File 5KB

Application extens... 9KB

= Recent places o s =
|‘ || Microsoft.IdentityServer.Servicehost.exe /1

4: Microsoft.|dentityServer.Utilities.dll
’ — il %] Microsoft.IdentityServer.Web.dll
#items 1item selected 4.53 KB

8
[#7 Microsoft.IdentityServer.ServiceHost 9/
-
9

B Desktop
i /15/2016 10:19 AM  Application extens... 794 KB v

-

# C:\Windows\ADFS\MicrosoftIdentityServer Servicehost.exe.config - Notepad++ [Administrator] =-a] x|

b

File Edit Search View Encoding Language Settings Macro Run Plugins Window 7 X
cHEHRE LB sBb e ny 2x B8 S1[ER@lae el BB
[ Microsoft Identity Server. Servicehost exe config £3 I

<section name="microsoft.identityServer.web" type="Microsoft.IdentityServer.Web.Configuration.FederationPass A
F </configSections>
<uri>
10 <idn enabled="All" />

<iriParsing enabled="true" />
F </uri>

<microsoft.identityServer serviceMode="Server" />

[ <microsoft.identityServer.web>

0
{1}
1L

)
n

[}
L T S )

/>

)
]

{T}

L

<localAuthenticationTypes enabled="true">

F </localAuthenticationTypes>
<useRelayStateForIdpInitiatedSignOn enabled ="true" />

</microsoft.identityServer.web>

[ <microsoft.identityServer.proxy>

)

© W0 W

NN NN

2 <host name="" httpPort="80" httpsPort="443" tlsClientPort="49443" />

3 <proxyTrust proxyITrustRenewPeriod="240" />

4 <connectionPool connectionPoolSize="200" scavengelnterval="5" /> ¥
<| 1] | >
|eXtensible Markup Language file length: 4,648 lines: 68 Ln:6 Col:105 Sel:0|0 Windows (CRLF)  UTF-8 INS
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Cloud Secure Integration with ADFS

Pulse Connect Secure Configuration

This section outlines the configurations for enabling PCS as SAML Identity Provider and configuring
ADFS as Service Provider in PCS.

Basic Role, Realm and VPN configurations are not covered in this guide.
For basic configurations details, refer Configuring Pulse Connect Secure - Basic Configurations (Mandatory)

Pulse Connect Secure configurations include:
e Enabling and configuring SAML in PCS.
e Adding ADFS metadata.
e Configuring ADFS as Service Provider.

Download/Upload ADFS metadata

After configuring and enabling Cloud Secure in ADFS, it gives metadata file. This file should be
uploaded in Pulse Connect Secure.

Download the AD FS server metadata file by navigating to this URL.

https://<ADFS FQDN>/FederationMetadata/2007-06/FederationMetadata.xm!

Configure ADFS as Service Provider

SAML allows cloud services to delegate user authentication to IdP. The IdP can also delegate the authentication to
another IdP, which is called IdP federation.

To add ADFS as third-party |dP provider:
1. Click Add New and select the Third-party IdP as Microsoft ADFS
Figure: UX: Third-Party IdP

Select IdP Provider

fueet okta Ping
Identity.

Click Done

Under User Identity, select the Subject Name format
Enter the Subject Name

Click Browse and upload the metadata file.

Enter the relay state.

Set the signature algorithm to Sha-1 or Sha-256.

© N O AW

Select the desired roles.
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9. Under Bookmark settings, enable the checkbox for Create Bookmark to configure bookmarks
for each SP configured with the third-party IDP.
You can configure multiple bookmarks for each SP configured with the Microsoft Active Directory Federation
Service (ADFS) server.

Enter the bookmark name.
Enter the relay state.
Enter the subject name format.

o n o W

Enter the subject name.
e. Click Add.
10. Enable the checkbox Enable Re-writer to redirect all the Cloud Secure traffic through PCS.

11. Configure the LDAP server for fetching the additional details.
12. Click OK.

Figure: UX: Third-Party IdP- ADFS Settings

Pulse Connect Secure

S e C U re Authentication Administrators Users Maintenance Wizards v

ure Configuration = Basic = Third-Parly IDP Setfings

Cloud Secure Configuration Cloud Application Visibility

Fes

MetadataFile @ FederationMetadata (8).xml
Relay state @ RPID=umfederationMicrosofOnline
signature Algorithm & ® sha-1 ) Sha-256
Select All Roles (Show Roles)
Bookmark SE“H’QS
Create Bookmark
Bookmark Name Relay State Subject Name Format SubjectName

0365 RPID=urn:federation:MicrosoftOnline persistent <OBJECTGUID=

. RPID=https-#/ngsa-test-dev- email <usemame>@pulsesecureqa.net
ed.my.salesforce.com

-selet-  |v Add ©

Enable Re-writer

LDAP server for fetching additional attributes that needs to be sent as part of SAML Attribute statements.

server LDAP_Server > (Show Details)

Help Section

oNote: Click Show IdP to view the details of the configured Third-Party |dP servers.
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Troubleshooting

For any issues with Pulse Connect Secure, submit a request with Pulse Secure support team and
provide following PCS logs:

e Navigate to System > Log/Monitoring. Click ‘Save All Logs' and save the logs

e Provide server debug logs with event codes “saml, auth, soap, dsdash, cloudsecure” at level
50

e Provide Policy tracing for the specific user session with proper realm

References

ADFS deployment and configuration: https://technet.microsoft.com/en-us/library/gg188612.aspx

Requesting Technical Support

Technical product support is available through the Pulse Secure Global Support Center (PSGSC). If you
have a support contract, then file a ticket with PSGSC.

e Product warranties—for product warranty information, visit https://www.pulsesecure.net.

) 2018 Pulse Secure, LLC All rights reserved.
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